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Editing images

Using
PhotoImpact SE

While some people are content to use clip-art and other free images
available all over the Internet, others want to add a personal touch,
or even design all of the images for their Web site themselves.
HoTMetaL pro comes with Ulead’s PhotoImpact se image editing
tools, which make it possible to do the following (and much more)
quickly and easily:

Adding text to images.

Creating buttons.

Creating shadows and frames.

Adding transparency to images.

Optimizing image colors for the Web.

If you didn’t install PhotoImpact se when you installed
HoTMetaL pro, you can do so now from the HoTMetaL pro cd.
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HoTMetaL pro comes with a rich collection of image editing tools in
Ulead’s PhotoImpact se. This powerful graphics program makes it easy
for you to customize and create professional looking graphics for your
Web pages. This manual does not cover all of the functionality of
PhotoImpact se; full documentation is available from PhotoImpact se’s
online help.

Choosing an
image editor/
viewer

PhotoImpact se is the default image editor for HoTMetaL pro, but you
can change the default editor and viewer for a particular image type from
the HoTMetaL pro Editor Options dialog. These applications will be
launched instead of the default for a file of that type when you click on
the image and choose Edit Image File or View Image File from the pop-up
menu.

Choose Options... from the HoTMetaL pro Editor Tools menu.

Click on the Helper Apps tab.

Enter the file extension for the image type in the File Extension text
box. If files of that type could have more than one extension (for
example, .jpg and .jpeg), you will have to make a separate entry for
each.

Click on Add New Type .

You can choose an editor, viewer, or both. Enter the locations and
filenames of of the desired applications in the Viewer and Editor text
boxes (you can use the Choose... button to select them).

Click on OK .
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Web image
basics

While you don’t need to be a graphics wizard to insert an image into your
page, before you begin it’s a good idea to understand a bit about how
images are displayed in the HoTMetaL pro Editor and in Web browsers. If
you’re already familiar with using images on the Web, you can skip this
section.
Images can enhance the appearance of your page and make it easier to
communicate your ideas, but they also increase the time it takes for
someone to load your page over the Internet. Here are some guidelines
for using images in your Web pages:

Try to keep your file sizes small. You can achieve this by keeping the
actual dimensions of the image small, and also by reducing the num-
ber of colors that are stored in the file. You can use graphics software
such as PhotoImpact se to reduce the number of colors in individual
image files.

Don’t rely exclusively on images to convey your information For
example, using only a logo image to give the name of your company
means that not everyone will get that important information.

Use alternate text for images. Providing a short text description of
the image in its ALT attribute makes your page accessible to more
people. Not only do some Web surfers still use text-based browsers
like Lynx, or surf with images turned off in their browsers to speed
up download time, but also people with visual impairments use voice
synthesis technology to surf the Web. By taking the time to enter a
meaningful description of your image you don’t exclude these people
from sharing your Web page.

Don’t use background images that make it difficult to read the text of
the page.
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Available image
formats

HoTMetaL pro can display many different image formats (for example,
bmp, tiff, jpeg, png, gif) in the document window. Not all of these
image formats are available to Web browsers, however, so you should
convert the images before you upload them to the Internet or an intranet.
The most common image format on the web is gif.
All browsers that are capable of displaying images can display gif files.
Most newer browsers can also display jpeg images, and some browsers
can display other platform-specific image types. If you want your Web
pages to be viewed by the broadest possible audience, however, make
sure that your images are in gif or jpeg format.

Note The HoTMetaL PRO Editor also supports the PNG
image format (portable network graphic), which is a standard
file format endorsed by the World Wide Web Consortium.
While few browsers currently display this graphics format
inline, future releases of Microsoft Internet Explorer and
Netscape Navigator will support PNG graphics.

GIF or JPEG? While gif files were once the standard image format on the Web, most
browsers now support jpeg files as well, and many people are confused
about which file format is ‘better’ for their Web images.
In fact, the two file formats are both good at specific tasks. The gif for-
mat uses a maximum of 256 colors, and uses combinations of these to
create colors beyond that number. The gif format is better for displaying
images that have been designed using a graphics program, like logos,
icons, and buttons. jpeg files can contain millions of colors, and are
much better for photographic images.
gif images come in two different versions and have some extra func-
tionality that jpegs do not. You can save gif images in gif 87 or gif 89a
format. gif 89a is newer and has the following features that gif 87 and
jpeg files do not:

Interlacing – if you save a gif 89a image as interlaced, the browser
will be able to display the image as it loads, getting gradually crisper
and clearer until it is finished. Interlaced gifs have slightly larger file
sizes than non-interlaced gifs, so you will have to decide whether
the interlacing effect is worth the extra download time for your
images.
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Transparency – with gif 89a format images you can set a single
color to be transparent, that is, it will allow the background color or
image to show through it. Transparency is most commonly used to
make the rectangular background canvas of an image invisible; this
feature can be very effective in Web page design. The image editing
software included with HoTMetaL pro, Ulead PhotoImpact se,
makes it easy to save transparent gifs (see page 49).

Animated gifs – gif 89a images can also be animated using special
software. Animated gif images are simply a number of gif images
saved into a single file and looped. Netscape Navigator and Micro-
soft Internet Explorer can both display animated gifs, but many
other browsers cannot, and may not be able to display even the first
image in the loop. Use animated gifs with caution. HoTMetaL pro
includes Ulead’s gif Animator software so you can create your own
animated gif images.

jpeg images don’t give you the option of including transparency or of
interlacing images, but they do allow you to specify the degree of file
compression so that you can create a balance between image quality and
file size. To learn more about how to do this using Ulead’s
PhotoImpact se, see page 42.

Image color One of the most difficult aspects of working with computer images—
especially over the Internet—is color. Good Web designers must always
keep in mind that the images they put on the Web may look different on
different machines depending on the user’s display capabilities. This sec-
tion gives a general overview of some image color issues. The Ulead
PhotoImpact se online help contains a detailed discussion of image
colors.

Image dithering Keep in mind that, while your images may look fine on your computer,
they may not look as good on other computers that may have fewer
colors in their displays. Many users will have computers that have 8 bit
displays, that is, they can display a maximum of 256 colors. This means
that if a user loads a true-color (millions of colors) jpeg image, the
browser has to use two pixels of different colors in combination to create
colors above the 256 colors available. This process is called dithering.
Because dithering uses two pixels to create a single color, it reduces the
image quality.
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Browser palettes In addition, Web browsers use their own internal color palettes (tables of
pre-defined colors available to create color images) to display images,
which can sometimes result in your true-color images looking different in
your browser. Many of the images provided with HoTMetaL pro are true-
color images, and may lose some of their quality on some systems and in
some browsers.

Multiple palette

problems

If you have a number of gifs that will appear in a single browser win-
dow, you should take steps to maintain the image quality by making sure
that their color palettes are compatible. For example, if you have two
images, one with 200 shades of red and one with 150 shades of green,
your total number of colors is more than 256. On systems that can dis-
play only 256 different colors, the browser will have to combine the pal-
ettes of each of these images and then dither both images to use the cus-
tom color palette. This results in lower image quality for both images. It’s
best to use a ‘browser safe’ palette for all of your gif images. See page 50
for instructions on how to use PhotoImpact se to save gif images with a
color palette optimized for the Web.

Introducing
PhotoImpact SE

PhotoImpact se consists of five main components:

1. PhotoImpact se Editor, for editing and creating images (this is the
default image editor for HoTMetaL pro).

2. PhotoImpact se Explorer, for browsing image thumbnails (this is
launched when you choose Image Explorer from the HoTMetaL pro
Tools menu).

3. PhotoImpact Album se, for organizing and grouping images.

4. PhotoImpact Viewer se, an image viewer (this is the default image
viewer for HoTMetaL pro).

5. PhotoImpact gif Animator, the default editor and viewer for
animated gifs.

This manual covers only certain aspects of the PhotoImpact se Editor.
You can learn about the other PhotoImpact applications from the
PhotoImpact online help.
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The
PhotoImpact SE
editor

The following is a basic introduction to the PhotoImpact se editor inter-
face.
To open an image file with PhotoImpact se Editor from HoTMetaL pro:

Right-click on the image in the HoTMetaL pro Editor window and
choose Edit Image File from the pop-up menu; this will start
PhotoImpact se and load the image file for editing.

You can also start PhotoImpact se from the Windows Start menu, or by
choosing Image Editor from the HoTMetaL pro Tools menu, and then open
the image file using the Open... command in the PhotoImpact se File
menu.
The main tools for using PhotoImpact se are the menus, the Standard
toolbar, the Tool Panel, and each tool’s Attributes toolbar. All of the tool-
bars and panels can be moved around the screen as floating toolbars, or
anchored to any part of the PhotoImpact se window.
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To configure PhotoImpact se to display these toolbars:

Choose Toolbars & Panels from the View menu.

Select the toolbars you want to display; we recommend that you
show the Standard Toolbar, the Attribute Toolbars, and the Tool Panel.

From this dialog, you can also set the size of the buttons and determine
whether or not to show tool tips.

The Switch menu

command

The Switch menu at the right-hand end of the menu bar of each
PhotoImpact se component gives you to access the PhotoImpact se Edi-
tor, Viewer, Explorer, and Album. If you choose a PhotoImpact se com-
ponent from the Switch menu, that component will start, or, if it is
already open, will come to the foreground.

Standard Toolbar The Standard toolbar gives quick access to frequently needed tools and
menu items.

Tool Panel The Tool Panel provides all the editing tools you need to work on images.
By selecting the appropriate tool, you can select, draw, transform, and
touch up images. Each tool has its own Attribute toolbar. Some of the
tools, such as the Paint tool, have different modes that you can select by
clicking on the small triangle in the bottom right corner of the tool but-
ton.

Attribute Toolbars When you select a tool in the Tool Panel, all of the attributes that you can
configure for that tool appear in the Attribute toolbar. Note: some
options may be grayed-out; typically, these options are not available in
PhotoImpact se, but are available in the full version of PhotoImpact.
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Working with
files

To open an image file with PhotoImpact se Editor from HoTMetaL pro,
right-click on the image in the HoTMetaL pro window and choose Edit
Image File from the pop-up menu. This will start PhotoImpact se Editor
or PhotoImpact gif Animator, as appropriate, and load the image file for
editing.
There are two other ways to launch PhotoImpact se:

Choose Image Editor from the Tools menu.

Start PhotoImpact se from the Windows Start menu

You can then open the image file using the Open... command in the
PhotoImpact se File menu.

Using
PhotoImpact SE
tools on GIF
image files

Most of the image filters and advanced image editing features work only
in true color 24-bit images (millions of colors). If you are editing gif files
for your Web pages, they will be 256 or fewer color images. To maximize
the number of features you can use when editing the image, you should
increase the number of colors while you work on the image in
PhotoImpact se, then reduce the colors to save it as a gif file again.

Note The PhotoImpact SE online help has a detailed section
on color, color palettes, and color depth.

To work on a gif file in true color 24-bit mode:

Open the gif file in PhotoImpact se.

Choose Data Type in the Format menu or click on the image type but-
ton in the bottom right corner of the PhotoImpact se window.

If Create a New Image is checked in the fly-out menu, deselect it by
clicking on it with the mouse.

Choose true color (24-bit) from the Data Type menu; the image is
converted to true color and all the image processing tools will be
available.

To resave the image as a gif file:

Choose Data Type in the Format menu or click on the image type but-
ton in the bottom right corner of the PhotoImpact se window.

Choose a color depth of 256 colors or fewer.
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Click on the or choose Save from the File menu to save your
changes to the gif file at the proper color depth.

PhotoImpact se gives you several options for color palettes, including
optimizing for the www (see page 50).
You can also use this process to reduce the colors of high color images
such as bmp and jpeg files before saving them as gif files.

Note If the file originally had only a 16 color palette, save it as
a 16 color file so that you don’t unnecessarily increase the file
size.

Using Smart
Savers to set
image options

Because both gif and jpeg files can be saved with several customizable
settings, PhotoImpact se includes Smart Savers for gif and jpeg files.
These make it easy to optimize your images for the Web. You can access
the Smart Savers by choosing Export... from the File menu, or by choosing
either the gif or jpeg Smart Saver from the Web menu.
The gif Smart Savers make it easy to set:

Transparency

Color reduction

Color palette

Interlacing on or off

The jpeg Smart Savers let you balance file size with image quality by set-
ting:

File compression

Smoothing

Mode

Subsampling

You can also run batch image processes from the Smart Savers. See
PhotoImpact se’s online help for more information.
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Adding text to
an image

With Ulead PhotoImpact se you can easily add text to images to person-
alize buttons, logos, and other customized Web graphics.
To add text to an image:

Click on the text tool icon; the mouse pointer becomes an I-bar and
the text tool settings toolbar appears below the main toolbar.

Click in the image window; this brings up the Text Entry Box dialog.

Type the text you want to place on your graphic. To put a line break
type Ctrl+Enter .

Click on OK ; this inserts the text into the graphic.

Click and drag the text to the desired location in the image.

Modifying image
text

You can change the properties of the text using the PhotoImpact se Text
toolbar:

Click on the (text) toolbar button in the Tool Panel.

Put the pointer over the text you want to change; the pointer arrow
will have a small ‘T’ inside it: .

Click on the text; it will have a dotted line around it, which means it
can be moved or changed.

You can now use the text Attributes toolbar to change the font, color,
style, size, and other options as described in the Ulead PhotoImpact se
online help.

To edit the text:

Click on the (text) toolbar button in the Tool Panel.

Put the pointer over the text you want to change; the pointer arrow
will have a small ‘T’ inside it: .

Double-click on the text; this brings up the Text Entry Box with the
current text in the editing box.

Edit the text.
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Click on Update ; the text will be updated in the image.

Adding text
shadows

A popular effect to use for creating text images is a drop-shadow beneath
the text. Ulead PhotoImpact se makes creating shadowed text easy:

Using the text tool, move the pointer over the text until the pointer
arrow has a small a small ‘T’ inside it: ; the text will be sur-
rounded by a moving dotted-line marquee.

Click on the text you want to shadow; it should have dotted lines
around it.

Click on the (Style) button in the Attributes Toolbar; this brings
up a menu of styles.

Choose Shadow from the style menu.

This creates a drop shadow of the text. You can change the appearance of
the shadow (position, distance from the original, color, etc.) by clicking
the styles button, and choosing Options from the menu.

Saving an image
with text

When you add text to an image, PhotoImpact se regards the text as a sep-
arate object that can be manipulated (for example, moved around or
deleted) independently of the image. Most image formats—for example,
gif and jpg—do not support objects, so if you save the image in one of
these formats, you will get a warning message informing you of this. In
this situation the text will be ‘merged’ into the image, which simply
means that it will become part of the image rather than residing on top of
the image. You can turn this warning message off for future saves.
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Web image
tricks

PhotoImpact se provides tools for easily creating images suitable for
Web pages. All of these tools are available from the Web menu. We have
provided information on only a few of the available tools in
PhotoImpact se; you can learn about the others from the PhotoImpact se
online help.

Creating buttons Adding graphical buttons to act as hypertext links is an easy way to give
your page a sense of style. PhotoImpact se can take a regular image and
add a variety of beveled-edge button styles. While buttons tend to look
better in gif format, the greatest range of button types is available if you
are working in 24-bit color; see the section on working with gif files
(page 41) for more about changing the Data Type.
To create a button effect for the image:

Open the image in PhotoImpact se.

If the image has less than 24-bit color, increase the color depth using
the Data Type command in the Format menu.

Choose Button Designer... from the Web menu.
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The easiest way to work with the Button Designer is to experiment until
you get the effect that you want. The following options are available:

Style – Click the style of button you want to create. The preview win-
dow will immediately display a preview of your image with that style
applied.

Direction – If you choose Outward, the button border will be added
to the outside of the current image, changing its size. If you choose
Inward, the button border will remain within the original borders of
the image, covering part of it.

Options – Specify the size, color, and other attributes for the button
border.

Mirror – Turn on Mirror to keep the top and left edge and the right
and bottom edge sizes synchronized with each other. Turn off Mirror
to set the size of each edge independently.

Width – Set the width of the selected edge.

Transparency – Set how much of the original image should show
through the button border.
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Colors – Depending on the type of button, choose the colors to use
for button borders or adjust other color attributes.

Quick samples – The buttons in the lower panel on the right-hand side
of the Button Designer are preset button settings. You can use them to
create a button with a single click; then fine tune the settings if you
wish.

Adding image
frames and
shadows

You can quickly create frames (borders) and shadows for entire images
by choosing Frame Designer... from the PhotoImpact se Web menu.
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This dialog gives a number of options:

Frame – Choose the width and color or pattern for the border; the
result is displayed in the preview image. You may choose any of these
types of borders for the image:

Color – A single color border matching that of the color square.
To choose a different color, right-click on the color square and
choose the desired command for selecting a new color.

Magic texture – Create a multi-color border matching that of the
texture square. To change textures, click on Library... and choose
from the samples in the Magic Texture dialog box.

Natural texture – Create a natural looking multi-color border
matching that of the texture square. To change textures, click on
Library... and choose from the samples in the Texture Library dia-
log box.

Shadow – Choose the size and color of a shadow to go around the
border.

Color and Direction – The shadow color will match that of the
color square. To choose a different color, right-click on the color
square and choose the desired command for selecting a new
color. Then select the option that shows a shadow in the direc-
tion you want.

X offset, Y offset – Set the size, in pixels, of the shadow. (X is the
distance of the shadow from either side, Y is the distance of the
shadow from the top or bottom.)

Transparency – Set a higher value to allow more of the underlying
image to appear through the shadow.

Edge blending – Set a higher value to have the shadow blend into
the background more smoothly.

Canvas – Set the size and color for the background.

Color – Choose a color for the background. To choose a differ-
ent color, right-click on the color square and choose the desired
command for selecting a new color.

Direction – Set the size for the background. Click on the Lock
button to set the sizes individually.
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Creating
seamless
backgrounds

Using the Shift Image... command in the PhotoImpact se Web menu, you
can adjust images so that they will tile seamlessly as a background image
in your page. The Shift Image dialog displays the image as your browser
would. Simply use the mouse to shift the preview image until the tiling
looks right. If you need to adjust the offset more precisely than you can
with the mouse, you can use the Horizontal Offset and Vertical Offset spin
boxes to choose precise values.

Creating
transparent GIFs

A transparent gif is a gif image in which one color is designated as
transparent, that is, it allows background images or colors to show
through. You can create transparent gif images using the
PhotoImpact se GIF SmartSaver....
To create a transparent area in a gif image:

Choose GIF SmartSaver... from the Web menu, or choose Export...
from the File menu and choose GIF SmartSaver... from the pop-up
menu.

In the GIF SmartSaver dialog, choose Pick Color from the Transparency
pull-down menu.

Click on the Transparent Area Preview Color square to choose a color
that will represent the transparent color.

Move the mouse pointer over the image on the left (the original
image) and hold down the Ctrl key; the pointer will turn into an
eyedropper tool. (If the image already contains a transparent color
you can make it solid by holding down the Alt key and clicking the
mouse button.)

Click on the color you want to make transparent; any part of the
image that contains that color will now take on the preview color
you chose, and this will be displayed in both the uncompressed and
compressed preview images.

Click on the Save As... button to save the image with the transparency
information.
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Using Web-safe
colors

PhotoImpact se gives you the option of saving gif images with a color
palette optimized for Web browsers. If you save your images using this
palette, you will ensure that browsers on all platforms will be able to dis-
play your images with the best quality available to the user’s computer.
To save your images using the color palette optimized for the Web:

Choose Data Type from the Format menu; (if you turn on Create a
New Image, a new copy of your image will be created, leaving your
original image intact).

Choose WWW Browser Optimized from the palette choices.

The image now has a color palette that is most suited to Web browsers.

PhotoImpact SE
tricks

Animating images – Animated gif files have become a popular fea-
ture of the Web. HoTMetaL pro includes the PhotoImpact gif Ani-
mator for creating animated gif images. Please note: if you open an
animated gif in the PhotoImpact se editor and save it again, the
image file will no longer be an animated gif; the first image of the
animation will be saved and the others will be lost. Neither the
PhotoImpact se Editor, Viewer, or Explorer display gif animations.
If you’re unsure whether a file is an animation, view it in an
animations-capable viewer (such as a Web browser or the
PhotoImpact gif Animator) to verify its format. To learn how to cre-
ate animated gifs, consult the PhotoImpact gif Animator online
help.

Making basic shapes – Rectangles, squares, ellipses, circles, and
polygons are easy to make with PhotoImpact se once you know the
tricks. PhotoImpact se does not have a specific tool for creating these
shapes, so it requires an extra step.
To create an outlined rectangle, square, ellipse, or circle:

Click on the (Standard Selection) toolbar button in the Tool

Panel.

Choose the shape you want to create from the Attributes toolbar.
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Drag the mouse in the editing window to produce a selection
area, defined by a dotted line. To make the selection a specific
size, check the Fixed size checkbox in the Attributes toolbar, and
set the size of the area.

Right-click on the area and choose Border from the pop-up
menu; this brings up a dialog box.

Choose the thickness of the border.

Click on OK . The selection will now be surrounded by a
double dotted line.

Click on the Fill tool icon.

Choose a fill color for the box outline from the Attributes tool-
bar.

Apply the fill between the selection outlines (use the Zoom tool
to do this if you have made a narrow border).

To create an irregular polygon:

Click on the (Lasso) toolbar button in the Tool Panel.

Click in the editing window to start drawing the figure.

Move the mouse to the second point in your drawing; a line will
follow the pointer from the location where you clicked the
mouse. Click the mouse again, the pointer will now be con-
nected to both points where you clicked before, creating a three-
pointed shape.

If you click and drag the mouse, you will draw a freehand line
rather than a series of connected points.

Continue clicking and moving the pointer until you have the
shape you like.

Double-click the mouse to stop drawing; this creates a selection
area surrounded by dashed lines.

Right-click on the area and choose Border from the pop-up
menu; this brings up a dialog box.

Choose the thickness of the border.

Click on OK . The selection will now be surrounded by a
double dotted line.
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Click on the Fill tool icon.

Choose a fill color for the box outline from the Attributes tool-
bar.

Apply the fill between the selection outlines (use the Zoom tool
to do this if you have made a narrow border).

Right-click color choosing – When you right-click on a color box in
dialog boxes or the Attributes toolbar, a pop-up menu appears giving
you a choice of color choosers. The eyedropper tool allows you to
choose a color from the current image so that you can be sure of a
match.
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